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CHAPTER 2. FLAT PLATE BOUNDARY LAYER

CHAPTER 2. FLAT PLATE BOUNDARY LAYER

A. Objectives

Creating the SOLIDWORKS part needed for the Flow Simulation
Setting up Flow Simulation projects for internal flow

Setting up a two-dimensional flow condition

Initializing the mesh

Selecting boundary conditions

Inserting global goals, point goals and equation goals for the calculations
Running the calculations

Using Cut Plots to visualize the resulting flow field

Use of XY Plots for velocity profiles, boundary layer thickness, displacement thickness,
momentum thickness and friction coefficients

Use of Excel templates for XY Plots

Comparison of Flow Simulation results with theories and empirical data
e  Cloning of the project

B. Problem Description

In this chapter, we will use SOLIDWORKS Flow Simulation to study the two-dimensional laminar
and turbulent flow on a flat plate and compare with the theoretical Blasius boundary layer solution and
empirical results. The inlet velocity for the 1 m long plate is 5 m/s and we will be using air as the fluid
for laminar calculations and water to get a higher Reynolds number for turbulent boundary layer
calculations. We will determine the velocity profiles and plot the profiles using the well-known
boundary layer similarity coordinate. The variation of boundary-layer thickness, displacement
thickness, momentum thickness and the local friction coefficient will also be determined. We will start
by creating the part needed for this simulation, see figure 2.0.

In]et section

Lines for velocity profiles _
Outlet section

Ideal walls

Real wall
Figure 2.0 SOLIDWORKS model for flat plate boundary layer study
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CHAPTER 2. FLAT PLATE BOUNDARY LAYER

C. Creating the SOLIDWORKS Part

1. Start by creating a new part in SOLIDWORKS: select File>>New and click on the OK button in
the New SOLIDWORKS Document window. Click on Front Plane in the FeatureManager
design tree and select Front from the View Orientation drop down menu in the graphics
window.

G B | &
4
@ 8 Partl (Default<<Default>_Displa

History
Sensors
J Annotations ﬁjv@v@gvgv

=
2= Material <not specified> y @ =

bl -

[ﬂTopPIane @ @ @ @

[1] Right Plane
1, origin Front (Ctrl+1)
Figure 2.1a) Selection of front plane Figure 2.1b) Selection of front view

2. Click on the Sketch tab and select Corner Rectangle.

? . .
_] DS SOLIDWORKS |  File Edit.
cC & |/-G-N-;
Sketch  Smart
= Dimr::sinn D -| & - @ e
& - ] Comer Rectangle

Features | Sketch [ E Center Rectangle

Figure 2.2 Selecting a sketch tool

3. Make sure that you have MMGS (millimeter, gram, second) chosen as your unit system. You can
check this by selecting Tools>>Options from the SOLIDWORKS menu and selecting the
Document Properties tab followed by clicking on Units. Check the circle for MMGS and click
on the OK button to close the window. Click to the left and below the origin in the graphics
window and drag the rectangle to the right and upward. Fill in the parameters for the rectangle,

w

see Figure 2.3a). Close the Rectangle dialog box by clicking on . Right click in the graphics

window and select Zoom/Pan/Rotate>>%" Zoom to Fit.
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Parameters ~
o -100.00 :
., 0.00 :
o -100.00 :
°, 100.00 :
° 1000.00 :
°, 100.00 :
° 1000.00 :
s 0.00 :

Figure 2.3a) Parameter settings for the rectangle

| Zoom/Pan/Rotate » |||ﬁ Zoom to Fit

Figure 2.3b) Zooming in the graphics window

Repeat steps 2 and 3 but create a larger rectangle outside of the first rectangle. Dimensions are
shown in figure 2.4.

Parameters ~
L. -120.00 :
L= -20.00 :
L. -120.00 :
L 120.00 :
L 1020.00 :
L 120.00 :
S 1020.00 :
= -20.00 :

Figure 2.4 Dimensions of second larger rectangle
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5. Select Features tab and Extruded Boss/Base. Check the box for [%| Direction 2 and click

OK to exit the Boss-Extrude Property Manager.

? F .
J,DS SOLIDWORKS | File Edit V

Swept Boss/Base
@ |

Extruded | Revolved Lofted Boss/Base
EBoss/Base | Boss/Base

@ Boundary Boss/Base

Figure 2.5a) Selection of extrusion feature

? .
_‘,DS SOLIDWORKS |  File Ed

Features | Sketch | Markup | Evaluate

SERI¢|€ T
@] Boss-Extrude1 @

v X @

Figure 2.5b) Closing the property manager

6. Select Front from the View Orientation drop down menu in the graphics window. Click on
Front Plane in the FeatureManager design tree. Click on the Sketch tab and select the Line
sketch tool.

_]pS SOLIDWORKS| File Edit View

C & |[A16G-NV-§

Sketch Smart .
Dimension d/ Line

A i
:r" Centerline

- -

Features | Sketch [ \ Midpoint Line

Figure 2.6 Selection of the line sketch tool
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7. Draw a vertical line in the positive Y-direction in the front plane starting at the lower inner

surface of the sketch. Set the Parameters and Additional Parameters to the values shown in
¥

figure 2.7. Close the Line Properties dialog

and the Insert Line dialog.

Parameters ~
£ 2000 i
&
(]
A = s -
|l 30.00 <
Additional Parameters ~
7, 2000 -
i -
/ 0.00 e
¥ -
/‘ 200.00 -
X -
/“ 20.00 &
r =
Ax 000 %,
AY 20,00 7

Figure 2.7 Parameters for vertical line

Repeat steps 6 and 7 three more times and add three more vertical lines to the sketch, the second
line at X = 400 mm with a length of 40 mm, the third line at X = 600 mm with a length of 60 mm
and the fourth line at X = 800 mm with a length of 80 mm. These lines will be used to plot the
boundary layer velocity profiles at different streamwise positions along the flat plate. Close the

Line Properties dialog L and the Insert Line dialog. Save the SOLIDWORKS part with the
following name: Flat Plate Boundary Layer Study 2020. Rename the newly created sketch in
the FeatureManager design tree, see figure 2.8. You will need to left click twice to rename the
sketch.

% ﬁ' Flat Plate Boundary Layer Study 2020
v History
Sensors
4 Annotations
v [®] Solid Bodies(1)
EE Material <not specified=>
[ﬂ Front Plane

[ﬂ Top Plane
[1] Right Plane

L Origin
4 @ Boss-Extrudel
[ (9x=0204,0608m
Figure 2.8 Renaming the sketch for boundary layer velocity profiles
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CHAPTER 2. FLAT PLATE BOUNDARY LAYER

9. Click on the Rebuild symbol e in the SOLIDWORKS menu. Repeat step 6 and draw a
horizontal line in the X-direction starting at the origin of the lower inner surface of the sketch. Set
the Parameters and Additional Parameters to the values shown in figure 2.9 and close the Line
Properties dialog and the Insert Line dialog. Click on the Rebuild symbol. Rename the sketch
in the FeatureManager design tree and call it x =0 — 0.9 m.

Parameters Ea

o
[

900,00 &

0.00%

1 ¥

Additional Parameters ~

“
7

e
se

AX

AY

26

0.00

4F 4 F
o |

0.00

900,00

4k 4

0.00

L3

900,00

1

000 -

-

Figure 2.9 Sketch of a line in the X-direction

10. Next, we will create a split line. Repeat step 6 once again but this time select the Top Plane and
draw a line in the Z-direction through the origin of the lower inner surface of the sketch. It will
help to zoom in and rotate the view to complete this step. Set the Parameters and Additional
Parameters to the values shown in figure 2.10 and close the dialog. Click on the Rebuild
symbol.

Parameters

& 2000 o
|1“ 90.00°

»

»

1

Additional Parameters

/ 0.00 o
x -
/ 10,00 -
T -
/ 0.00 -
x -
/' 10.00 -
Y -

b

Ax 0.00 i
AY 20,00 =

-

Figure 2.10 Drawing of a line in the Z-direction
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11. Rename the new sketch in the FeatureManager design tree and call it Split Line. Select
Insert>>Curve>>Split Line... from the SOLIDWORKS menu. Select Projection under Type
to Split. Select Split Line for Sketch to Project under Selections. For Faces to Split, select the

v

surface where you have drawn your split line, see figure 2.11b). Close the dialog . You have

now finished the part for the flat plate boundary layer. Select File>>Save from the
SOLIDWORKS menu.

Tools Window Help » | ﬁ- D -

Boss/Base r
Cut r

Features r
Pattern/Mirror [
Fastening Feature [
FeatureWorks [

Surface *

Face 3
| Curve [ | @ Split Line...
Figure 2.11a) Creating a split line

Features | Sketch | Evaluate | MED Dimensions | SOLIDWORKS Add-Ins | SOLIDWORKS CAM | SOLIDWORKS CAM TEM

G BBl €
& split Line @)
v X

Type of Split ~
@) Silhouette

@ Projection
@) Intersection

Selections Ca

E split Line

o
Single direction
|:| Reverse direction

Figure 2.11b) Selection of surface for the split line
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D. Setting Up the Flow Simulation Project

12. If Flow Simulation is not available in the menu, you have to add it from SOLIDWORKS menu:
Tools>>Add Ins... and check the corresponding SOLIDWORKS Flow Simulation 2020 box
under SOLIDWORKS Add-Ins and click OK to close the Add-Ins window. Select Tools>>Flow
Simulation>>Project>>Wizard to create a new Flow Simulation project. Enter Project name:
“Flat Plate Boundary Layer Study”. Click on the Next > button. Select the default SI (m-kg-s)
unit system and click on the Next> button once again.

Tools | Window  Help ,f‘ ﬁav@vﬁv%-

s
SOLIDWORKS Applications L Display/Dele
Kpress Products r ’ !
Floy [ Mew.. Project

SOl % Wizard...
Figure 2.12a) Starting a new Flow Simulation project

Inceart

Wizard - Project Mame

Froject

Froject name: Flat Plate Boundary Layer Study

Comments:

L 8

Figur:e 2.i2b) Creating a name for the project

13. Use the default Internal Analysis type and click on the Next> button once again.

Wizard - Analysis Type ? *
Analyziz type Conzider clozed cavities @
@ Intemnal [+ Exclude cavities without flow conditions [l
() External Exclude internal space

Physical Features lue
Heat conduction in solids
Radiation
Time-dependent

Gravity

Rotation

Free surface

Figure 2.13 Exclusion of cavities without flow conditions

ooodods
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14. Select Air from the Gases and add it as Project Fluid. Select Laminar Only from the Flow

Type drop down menu. Click on the Next > button. Use the default Wall Conditions and click
on the Next > button. Insert 5 m/s for Velocity in X direction as Initial Conditions and click on
the Finish button. You will get a fluid volume recognition failure message. Answer Yes to this

question and create a lid on each side of the model. Answer Yes to the questions when you create
the lids.

Wizard - Default Fluid 7 *
Fluids Palh ~ New »
E Gases
& Pre-Defined

Acetone Pre-Defined
Pre-Defined
Argon Pre-Defined
Pre-Defined
Pre-Defined
Pre-Defined
Pre-Defined

Ammonia

Butane
- Carbon dioxide
i Chlorine
- Ethane
- Ethanol

Pre-Defined v Add
Project Fluids Default Fluid Remove
Air ( Gases )

Flow Characteristic Value
Flow type Laminar Only
High Mach number flow D

idi [

Figure 2.14 Selection of fluid for the project and flow type

15. Select Tools>>Flow Simulation>>Computational Domain.... Click on the 2D simulation

W

button under Type and select XY plane. Close the Computational Domain dialog

[

Tools | Window Help ;f| ﬁDv@vﬁv@v

re

SOLIDWORKS Applications 4

Kpress Products 3

Flow Sirmulation

SOLIDWORKS CAM

m Ascet Publisher...

&, Defeature...

Project
Insert

General Settings...
_'_4;-_;_: Units...

@ Computational Domairn...

Figure 2.15a) Modifying the computational domain

@ Computational Domain @
v X
Type s

@ XY plane

Figure 2.15b) Selecting 2D simulation in the XY plane
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16. Select Tools>>Flow Simulation>>Global Mesh.... Select Manual under Type. Change Nx to
300 and Ny to 200. Click on the OK button (green check mark) to exit the Initial Mesh window.

Tools

Window Help :.f‘ ﬁ- D

4

m-@- 8- -

e
SOLIDWORKS Applications
Kpress Products

Flow Simulation

Project

SOLIDWORKS CAM

ﬁ Asset Publisher...

.....

B Defeature..
T+ Export To AEC..
Figure 2.16a) Modifying the initial mesh

3 Global Mesh Settings @
v X
Type

Automatic
Manual

Basic Mesh L)
Nx 300 %
Ny 200 %

Insert

General Settings...
Units...

Computational Domain...

60K’

Global Mesh...

Figure 2.16b) Changing the number of cells in two directions
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E. Selecting Boundary Conditions

17. Select the & Flow Simulation analysis tree tab, open the Input Data folder by clicking on
the plus sign next to it and right click on Boundary Conditions. Select Insert Boundary
Condition.... Select Wireframe as the Display Style. Right click in the graphics window and
select Zoom/Pan/Rotate>>Zoom to Fit. Once again, right click in the graphics window and
select Zoom/Pan/Rotate>>Rotate View. Click and drag the mouse so that the inner surface of
the left boundary is visible. Right click again and unselect Zoom/Pan/Rotate>>Rotate View.
Right click on the left inflow boundary surface and select Select Other. Select the Face
corresponding to the inflow boundary. Select Inlet Velocity in the Type portion of the Boundary
Condition window and set the velocity to 5 m/s in the Flow Parameters window. Click OK to

exit the window. Right click in the graphics window and select Ql Zoom to Area and select an
area around the left boundary.

£5: Flat Plate Boundary Layer Study
Eﬁ. Input Data

Figure 2.17a) Inserting boundary condition

l[%&..

Ef Inlet Velocity 1
v X

Selection ~

w Face<l>

,

}z—"»x Face Coordinate System

Reference axis: Q

Type .S
Inlet Mass Flow -
Inlet Mass Flux

Inlet Volume Flow H
lnl umbel

Outlet Mass Flow

Outlet Volume Flow il
Flow Parameters o~

V 5smis ]

Fully developed flow

------- @ Computational Domain
....... @ Fluid Subdemains Zoom/Pan/Rotate * ,@ Zoom to Fit
....... m Boundary Conditions .fi Zoom to Area
....... F Goals W 0K "
| @ N~ % Cancel p Zoom In/Out
-0 Results (Not loaded) C' Rotate View

Figure 2.17b) Modifying the view

Figure 2.17c) Velocity boundary condition on the inflow
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™
H=3

Figure 2.17d) Inlet velocity boundary condition indicated by arrows

. Red arrows pointing in the flow direction appears indicating the inlet velocity boundary

condition, see figure 2.17d). Right click in the graphics window and select Zoom to Fit. Right
click again in the graphics window and select Rotate View once again to rotate the part so that

the inner right surface is visible in the graphics window. Right click and click on &Select.

Right click on Ef Boundary Conditions in the Flow Simulation analysis tree and select
Insert Boundary Condition.... Right click on the outflow boundary surface and select Select
Other. Select the Face corresponding to the outflow boundary. Click on the Pressure Openings
button in the Type portion of the Boundary Condition window and select Static Pressure. Click
OK to exit the window. If you zoom in on the outlet boundary, you will see blue arrows
indicating the static pressure boundary condition, see figure 2.18b).

éfox Face Coordinate System

Reference axis: x.

Type ~

[ &~

Environment Pressure

101325 Pa

Static Pressure
Total Pressure

Thermodynamic Parameters ~
P 101325 Pa
T 2932k

Goals w

Figure 2.18a) Selection of static pressure as boundary condition at the outlet of the flow region
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1
1
|
i
1
1
1
1
1
1
1
1
1
|
|
|
|
1
1
1
1
1
1
1
1
1

Figure 2.18b) Outlet static pressure boundary condition

19. Enter the following boundary conditions: Ideal Wall for the lower and upper walls at the inflow

region, see figures 2.19. These will be adiabatic and frictionless walls.

1= Ideal Wall 1 @
v X
Selection -~
m Face<l>

Face<2>

};’x Global Coordinate Spstemn

Reference axis: g}
Type -~

BE)-

| Real Wall ‘

Ideal Wall

Figure 2.19 Ideal wall boundary condition for two wall sections
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20. The last boundary condition will be in the form of a Real Wall. We will study the development
of the boundary layer on this wall.

I} Real Wall 1 @
v X

Selection ”~
m Face<l>

:

.g’x Face Coordinate System

Reference axis: 5'

Type £

B
Real Wall |
Ideal Wall

Figure 2.20 Real wall boundary condition for the flat plate

F. Inserting Global Goals and Calculation Controls

21. Right click on Goals in the Flow Simulation analysis tree and select Insert Global Goals....
Select Friction Force (X) as a global goal. Exit the Global Goals window. Right click on Goals

X
in the Flow Simulation analysis tree and select Insert Point Goals.... Click on the *z| point

Coordinates button. Enter 0.2 m for X coordinate and 0.02 m for Y coordinate and click on the

Add Point button \i‘ Add three more points with the coordinates shown in figure 2.21e). Check
the Value box for Velocity (X). Exit the Point Goals window. Rename the goals as shown in
figure 2.21f). Right click on Goals in the Flow Simulation analysis tree and select Insert
Equation Goal.... Click on PG Velocity (X) at x = 0.2 m goal in the Flow Simulation analysis
tree, multiply by 0.2 (for x = 0.2 m) and divide by /.5/6E-5 (kinematic viscosity of air at room
temperature (v = 1.516E-5 m?%/s) to get an expression for the Reynolds number in the Equation
Goal window, see figure 2.21g). Select Dimensionless LMA from the dimensionality drop down
menu. Exit the Equation Goal window. Rename the equation goal to Reynolds number at x =
0.2 m. Insert three more equation goals corresponding to the Reynolds numbers at the three other
x locations. For a definition of the Reynolds number, see page 2-21.
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==
=

Flat Plate Boundary Layer Study
El@ Input Data
....... @ Computational Domain
....... @ Fluid Subdomains
|_:_| Eﬁ Boundary Conditions
....... Eﬁ Inlet Velocity 1
....... Eﬁ Static Pressure 1
....... Eﬁ Ideal Wall 1
....... Eﬁ Real Wall 1
...... p Goj

El""ﬂ Me
Figure 2.21a) Inserting global goals

Insert Global Goals...

Eﬂ Gaale

Insert Global Goals...

Insert Point Goals...

Flgure 2 21c) Inserting point goals

Add point

SYE ¥ [m] ¥ [m] Z [m]
0.2 0.02 0
0.4 0.02 0
0.6 0.02 0
0.3 0.02 0

Figure 2.21¢) Coordinates for point goals

R Global Goals @
L

Parameters ~
Parameter Mir A Mi Bu Us =

Density [Fluid)

Mass (Fluid)

Mass Flow Rate =
Velocity
Velocity [¥]
Velocity (¥
Velocity [2)

Mach NMumber

Heat Flux

Wall Temperature E
Heat Transfer Rats

Total Enthalpy Ra
Mormal Force
Maormal Force [X)
Mormal Force [Y)
Mormal Force ()
Force

Farce [¥)

Farce Y)

Farce [

Friction Farce

Friction Farce [X) _ .

Figure 2.21b) Selection of friction force

HiEEEEEEEEEEEEEEEEEEEE

K o

jl=

¥, Point Goals

LU 4

D |

Figure 2.21d) Selecting point coordinates
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B Goals

. LB GG Friction Force ()1

#. PG Velocity () atx =02 m B Z Y | | Reynolds numberat x = 0.2 m | |Dimension| LMA
-2 PG Velocity () atx= 0.4 m
%, PG Velocity (X) atx=0.6 m | Expression

#. PG Velocity' (Matx=08m {PG Velocity (<] at » = 0.2 m§*0.2/1.516E-5

Figure 2.21f) Renaming the point goals  Figure 2.21g) Entering an equation goal

Select Tools>>Flow Simulation>>Calculation Control Options from the menu. Select the
Refinement tab. Set the Value to level = 2 for Global Domain. Select Goal Convergence and

Iterations as Refinement strategy. Click on -] in the Value column for Goals and check all the
boxes in the Table. Select the Finishing tab and uncheck the Travels box under Finish
Conditions. Set the Refinements Criteria to 2.

G. Running the Calculations

22. Select Tools>>Flow Simulation>>Solve>>Run from the SOLIDWORKS menu to start the

calculations. Click on the Run button in the Run window. Click on the goals 2 button in the
Solver window to see the List of Goals.

Tools | Window  Help b8 ‘ ﬁ- D - E? - ﬁ -

F
SOLIDWORKS Applications 3
Apress Products k
Flow Simulation k Project
SOLIDWORKS CAM 3
Insert
ﬁ‘ Asset Publisher...
General
_:Jm.':.: Units...
B Defeature... @ Compu
=+ Export To AEC.. Bl Globall
Compo
I} Select B 3
- . Calcula
Cﬂ Magnified Selection
Jed b Run. | sohe

Figure 2.22a) Starting calculations
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Run

Startup
| Mezh
[+] Salve

(®) Mew calculation

Continue calculation

Figure 2.22b) Run window

Fiun

T ake previous results

Claze

Help

@ Solver: Flat Plate Boundary Layer Study [Default] (Flat Plate Boundary Layer Study 2020.5LDPRT)

File Calculation View Inset Window Help

B> 9 | BOE|He| O

i B Log
Parameter Value Event [teration Time
Status Solver is finished,| | Mesh generation started 0 10:51:30
Total cells 120,018 Mesh generation normally finished 0 10:51:33
Fluid cells 120,018 Preparing data for calculation 0 10:51:33
Fluid cells contacting solids 3,269 Calculation started 0 10:51:37
[terations 202 Refinement 120 10:54:22
Last iteration finished 10:57:08 Refinement 161 10:55:34
CPU time per last iteration 00:00:02 Calculation has converged since the follo... 202 10:57:08
Travels 242448 Goals are converged 202
[terations per 1 travel Rl Calculation finished 202 1:57:11
Cpu time 0:5:34
Calculation time left 0:0:0
Run at DESKTOP-|EOVIKY
Mumber of cores 4

Figure 2.22¢) Solver window

Mame Current Value
GG Friction Force (X} 1 (0.00014 |
PG Velocity (X) atx =02 m 5.06906 m/s
PG Velocity (X) atx = 0.4 m 509546 m/s
PG Velocity (X) atx = 0.6 m 511611 m/s
PG Velocity (X) atx = 0.8 m 513344 m/fs
Reynolds numberatx = 0.2 m 66874.1
Reynolds numberatx = 0.4 m 134445
Reynolds numberatx = 0.6 m 202435
‘Reynolds number atx = 0.8 m 270894

Progress

Criterion Averaged Value
B. 5 0.000146838 N
0.00204144 n - 5.068%4 m/s
0.00281354 n 509572 m/s
0.0033%282 n 511628 m/s
0.00320065 n 513344 m/s
269319 606872.5

74,236 134452

134518 202491

200.562 270894
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H. Using Cut Plots to Visualize the Flow Field

38

Open the Results folder, right click on R Cut Plots in the T Flow Simulation analysis tree
under Results and select Insert.... Select the Front Plane from the FeatureManager design
tree. Slide the Number of Levels slide bar to 255. Select Pressure from the Parameter drop
down menu. Click OK to exit the Cut Plot window. Figure 2.23a) shows the high pressure region
close to the leading edge of the flat plate. Rename the cut plot to Pressure. You can get more
lighting on the cut plot by selecting Tools>>Flow Simulation>>Results>>Display>>Lighting
from the SOLIDWORKS menu. Right click on the Pressure Cut Plot in the Flow Simulation
analysis tree and select Hide.

Repeat this step but instead choose Velocity (X) from the Parameter drop down menu. Rename

the second cut plot to Velocity (X). Figures 2.23b) and 2.23c) show the velocity boundary layer
close to the wall.

-

101324.99 101326.25 101327.51

Fressure [Pa]
Figure 2.23a) Pressure distribution along the flat plate

—

-0.197 2476 5.1449

Velocity (=) [mis]
Figure 2.23b) X — Component of Velocity distribution on the flat plate

Figure 2.23c) Close up view of the velocity boundary layer
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I. Using XY Plots with Templates

23. Place the file “graph 2.24c).xIsm” on the desktop. This file and the other exercise files are
available for download at the SDC Publications website. Click on the FeatureManager design

=
tree. Click on the sketch x = 0.2, 0.4, 0.6, 0.8 m. Click on the ™= Flow Simulation analysis

tree tab. Right click XY Plot and select Insert.... Check the Velocity (X) box. Open the
Resolution portion of the XY Plot window and slide the Geometry Resolution as far as it goes
to the right. Click on the Evenly Distribute Qutput Points button and increase the number of
points to 500. Open the Options portion and check the Display boundary layer box. Select the
“Excel Workbook (*.xlIsx)” from the drop-down menu. Click Export to Excel to create the XY
Plot window. An Excel file will open with a graph of the velocity in the boundary layer at
different streamwise positions.

Double click on the graph 2.24c¢) file to open the file. Click on Enable Content if you get a
Security Warning that Macros have been disabled. If Developer is not available in the menu of
the Excel file, you will need to do the following: Select File>>Options from the menu and click
on the Customize Ribbon on the left hand side. Check the Developer box on the right hand side
under Main Tabs. Click OK to exit the Excel Options window.

Click on the Developer tab in the Excel menu for the graph 2.24c¢) file and select Visual Basic
on the left hand side to open the editor. Click on the plus sign next to VBAProject (XY Plot
1.xIsx) and click on the plus sign next to Microsoft Excel Objects. Right click on Sheet2 (Plot
Data) and select View Object.

Select Modulel in the Modules folder under VBAProject (graph 2.24c¢).xIsm). Select
Run>>Run Macro from the menu of the MVB for Applications window. Click on the Run
button in the Macros window. Figure 2.24c) will become available in Excel showing the
streamwise velocity component u (m/s) versus wall normal coordinate y (m). Close the XY Plot
window and the graph 2.24c¢) window in Excel. Exit the XY Plot window in SOLIDWORKS
Flow Simulation and rename the inserted xy-plot in the Flow Simulation analysis tree to
Laminar Velocity Boundary Layer.
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G BB 4 € W

¥
% ? Flat Plate Boundary Layer Study 2020
g History
Sensors
r Annotations
» [®] Solid Bodies(3)
EE Material <not specified=
[ﬂ Front Plane
[ﬂ Top Plane
[ Right Plane
L Origin
ﬁ Boss-Extrude!
IC ()%x=02,04,06,08m
[ ()x=0-09m
v B split Linel
@ uo
[@ o2

Figure 2.24a) Sketch for the XY Plot

-
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[IPressure
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Figure 2.24b) Settings for the XY Plot
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Figure 2.24c) Boundary layer velocity profiles on a flat plate at different streamwise positions
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J. Comparison of Flow Simulation Results with Theory and Empirical Data

24.

u/U

We now want to compare this velocity profile with the theoretical Blasius velocity profile for
laminar flow on a flat plate. First, we have to normalize the streamwise Velocity (X) component
with the free stream velocity. Secondly, we need to transform the wall normal coordinate into the
similarity coordinate for comparison with the Blasius profile. The similarity coordinate is
described by

n= y\/% (2.1)

where y (m) is the wall normal coordinate, U (m/s) is the free stream velocity, x (m) is the
distance from the leading edge and v (m?%/s) is the kinematic viscosity of the fluid.

Place the file “graph 2.25a)” on the desktop. Repeat step 24 to plot Figure 2.25a). Rename the
xy-plot to Comparison with Blasius Profile.

We see in figure 2.25a) that all profiles at different streamwise positions collapse on the same
Blasius curve when we use the boundary layer similarity coordinate.

1 P
,,,f&”’/f;&
0.8 /
0.6 ,z/
zi ffffffffff x=0.2m
i’jl ******* x=0.4m
;,/ ffffff x=0.6m
0.4 /
7 1 I x=0.8m
—— Theory
0.2
0
0 1 2 4 5 6
n

Figure 2.25a) Velocity profiles in comparison with the theoretical Blasius profile (full line)
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The Reynolds number for the flow on a flat plate is defined as

Re, =% 22
X

v
The boundary layer thickness 6 is defined as the distance from the wall to the location where the

velocity in the boundary layer has reached 99% of the free stream value. The theoretical

expression for the thickness of the laminar boundary layer is given by
4.91x

- JRex

2.3)

, and the thickness of the turbulent boundary layer

0.16x
6= W (24)
From the data of figure 2.24¢) we can see that the thickness of the laminar boundary layer is close
to 3.80 mm at Re, = 66,874 corresponding to x = 0.2 m. The free stream velocity at x = 0.2 m is
U= 5.069 m/s, see figure 2.22¢) for list of goals in solver window, and 99% of this value is Us =
5.019 m/s. The boundary layer thickness 6 = 3.83 mm from Flow Simulation was found by
finding the y position corresponding to the Ug velocity. This value for § at x = 0.2 m and
corresponding values further downstream at different x locations are available in the Plot Data for
Figure 2.25a). The different values of the boundary layer thickness can be compared with values
obtained using equation (2.3). In Table 2.1 are comparisons shown between boundary layer
thickness from Flow Simulation and theory corresponding to the four different Reynolds numbers
shown in figure 2.24c). The Reynolds number varies between Re, = 66,874 at x = 0.2 m and

Re, =270,894 at x = 0.8 m.

x (m) | & (mm) § (mm) | Percent (%) Us U m? Re,
Simulation | Theory | Difference (m/s) v (T)

0.2 3.796 3.797 0.04 5.018 5.069 | 0.00001516 | 66,874

0.4 5.350 5.356 0.12 5.045 5.095 | 0.00001516 | 134,445

0.6 6.497 6.547 0.76 5.065 5.116 | 0.00001516 | 202,485

0.8 7.452 7.547 1.26 5.082 5.133 | 0.00001516 | 270,894

Table 2.1 Comparison between Flow Simulation and theory for laminar boundary layer thickness

Place the file “graph 2.25b)” on the desktop. Repeat step 24 to plot Figure 2.25b). Rename the
xy-plot to Boundary Layer Thickness.

0.1
10(l)00 100000 100(L000

s/x |l e Flow Simulation

—— Theory

0.01

Re x

Figure 2.25b) Comparison between Flow Simulation and theory on boundary layer thickness
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25. We now want to study how the local friction coefficient varies along the plate. It is defined as the
local wall shear stress divided by the dynamic pressure:

Tw
o= 2.5)

The theoretical local friction coefficient for laminar flow is given by

0.664
Crx = Tre Re, < 5-10° (2.6)
and for turbulent flow
Crx = % 5-105 < Re, < 107 2.7)

Place the file “graph 2.26” on the desktop. Repeat step 24 but this time choose the sketch x =0 —
0.9 m, uncheck the box for Velocity (X) and check the box for Shear Stress. Use the file “graph
2.26” to create Figure 2.26. Rename the xy-plot to Local Friction Coefficient. Figure 2.26
shows the local friction coefficient versus the Reynolds number compared with theoretical values
for laminar boundary layer flow.

0.1
1(LO 1000 IO(LOO 100000 100(1)000
Cf’x 0.01 Flow Simulation
\\ —— Theory
0.001
Re

X

Figure 2.26 Local friction coefficient as a function of the Reynolds number

The average friction coefficient over the whole plate Cr is not a function of the surface roughness
for the laminar boundary layer but a function of the Reynolds number based on the length of the
plate Re;, see figure E3 in Exercise 8 at the end of this chapter. This friction coefficient can be
determined in Flow Simulation by using the final value of the global goal, the X-component of
the Shear Force F7, see figure 2.22¢), and dividing it by the dynamic pressure times the area 4 in
the X-Z plane of the computational domain related to the flat plate.

_ Fp 0.0001475N _
Cr = pUZA  31.204kg/m*52m?/s2-1m-0.004m 0.00245 (2.8)
Rey == _SM/sim__ _ 33.1¢5 (2.9)

v~ 1.516:10~5m2/s
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The average friction coefficient from Flow Simulation can be compared with the theoretical value
for laminar boundary layers

1328 105
Cr = o 0.002312 Re;, <5-10 (2.10)
This is a difference of 6 %. For turbulent boundary layers the corresponding expression is
0.0315
Cr = ro T 5-105 < Re, < 107 (2.11)

If the boundary layer is laminar on one part of the plate and turbulent on the remaining part, the
average friction coefficient is determined by

0.0315 1 s
Cr = o7 ~ e, (0:0315Req,” - 1.328,/Re,,) (2.12)

where Re,, is the critical Reynolds number for laminar to turbulent transition.
K. Cloning of the Project

26. In the next step, we will clone the project. Select Tools>>Flow Simulation>>Project>>Clone
Project.... Enter the Project Name “Flat Plate Boundary Layer Study Using Water”. Select
Create New Configuration and exit the Clone Project window. Next, change the fluid to water
in order to get higher Reynolds numbers. Start by selecting Tools>>Flow Simulation>>General
Settings... from the SOLIDWORKS menu. Click on Fluids in the Navigator portion, select Air
and click on the Remove button. Select Water from the Liquids and Add it as the Project Fluid.
Change the Flow type to Laminar and Turbulent, see figure 2.27d). Click on the OK button to
close the General Settings window.

Tools | Window Help b g ‘ ﬁ- D - E? - ﬁ -

Y
SOLIDWORKS Applications b
Kpress Products [ i
Floy [ MNew.. Project
S0U % Wizard... -

Insert
T Ass (5 Rebuild
Automatic Rebuild

F& Display All Callouts
Show Basic Mesh

General £
Units...

Comput:
Global M

B, Def

#: Basic Mesh Color

AL
Sele Clone Project...

Fi_gure 2.27a) Cloning the project
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Clone Project @
W X
Project Name ~

Flat Plate Boundary Laver Study Using ' ater

Configuration ~
F@ [Creaie New v] Tools | Window Help b g ‘ ﬁ- D - E? - ﬁ - g -
= Defaul1) SOLIDWORKS Applications 4 [;ispla:-'?li;elete
Xpress Products 3 Relations
% [Dﬂau“ v] | Flow Simulation » Project
SOLIDWORKS CAM ,
Options rs Insert
Asset Publisher...
[] Copy results T Asset Publis E_r General Settings..
Figure 2.27b) Creating a new project Figure 2.27c) Selection of general settings
General Settings ? >
- DXygen Pre-Defined @ i
------ Propane Pre-Defined naysis ype
o R123 Pre-Defined @ Flid
.. R134a Pre-Defined T
e R22 Pre-Defined @ wiall coni
‘.. RCIB Pre-Defined = renaians
Non-Newtonian
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Water { Liguids } [+
Flow Characteristic Value
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Figure 2.27d) Selection of fluid and flow type
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27. Select Tools>>Flow Simulation>>Computational Domain... Set the size of the computational

domain to the values shown in figure 2.28a). Click on the OK button to exit. Select Tools>>Flow
Simulation>>Global Mesh... from the SOLIDWORKS menu, select Manual Type and change
the Number of cells per X: to 400 and the Number of Cells per Y: to 200. Also, click on
Control Planes. Change the Ratio for X to -5 and the Ratio for Y to -100. Click on the green
check mark above Ratio, see Figure 2.28b). This will increase the number of cells close to the
wall where the velocity gradient is high. Select Tools>>Flow Simulation>>Calculation Control
Options... from the SOLIDWORKS menu. Change the Maximum travels value to 5 by first
changing to Manual from the drop-down menu. Travel is a unit characterizing the duration of the
calculation. Click on the OK button to exit.

Size and Conditions A
, [0 SIEE
@:|J}.12m |%| v|
&, [0.10001 m SIEN
@v|-1e4}054m |%| "’|
@, 0002 m ST
&9, [0002m ST

Figure 2.28a) Setting the size of the computational domain
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Figure 2.28b) Increasing the number of cells and changing the distribution of cells
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Tools | Window  Help o ﬁ- D = E? = ﬁ = g = = hﬂ =
= I
SOLIDWORKS Applications » Display/Delate o
Xpress Products 3 SELEUTE Sketch | 2P
| Flow Simulation » Project
SOLIDWORKS CAM 3
Insert
ﬁ Asset Publisher... .
General Settings...
S :—E; Units...
B Defeature... @ Computational Domain...
s Export To AEC.. B Global Mesh..
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Figure 2.28c) Calculation control options
Calculation Control Options
Finizhing ' Refinement  Sokving  Saving
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Figure 2.28d) Setting maximum travels

Select Tools>>Flow Simulation>>Project>>Show Basic Mesh from the SOLIDWORKS menu.

Goals convergence All Goals
|:| terations
Travels manual

[vis

Q.
Cancel

Help

3
*

We can see in figure 2.28f) that the density of the mesh is much higher close to the flat plate at
the bottom wall as compared to the region further away from the wall.

Window  Help »

ald-F & =2

Figure 2.28¢) Showing the basic mesh
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Figure 2.28f) Mesh distribution in the X-Y plane

Right click the Inlet Velocity Boundary Condition in the Flow Simulation analysis tree and
select Edit Definition.... Open the Boundary Layer section and select Laminar Boundary
Layer. Click OK to exit the Boundary Condition window. Right click the Reynolds number at
x = 0.2 m goal and select Edit Definition.... Change the viscosity value in the Expression to
1.004E-6. Click on the OK button to exit. Change the other three equation goals in the same way.

Select Tools>>Flow Simulation>>Calculation Control Options from the menu. Select the
Refinement tab. Set the Value to level = 2 for Global Domain. Select Goal Convergence and

Iterations as Refinement strategy. Click on 2=/ in the Value column for Goals and check all the
boxes in the Table. Select the Finishing tab and uncheck the Travels box under Finish
Conditions. Set the Refinements Criteria to 2.

Select Tools>>Flow Simulation>>Solve>>Run to start calculations. Click on the Run button in
the Run window.

Boundary Layer
() Turbulent
i@ Laminar
Figure 2.29a) Selecting a laminar boundary layer

P’.‘ Eﬁ Z l'} | |Heynﬂldsnumberatx:'|].2m Dimensionless LMA

Ewpresszion
{PG Velocity [+] at = = 0.2 m}*0.2/1.004E -6
Figure 2.29b) Modifying the equation goals
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Figure 2.29c) Creation of mesh and starting a new calculation
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Figure 2.29d) Solver window and goals table for calculations of turbulent boundary layer
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29. Place the file “graph 2.30a)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,

0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Velocity
Boundary Layer. An Excel file will open with a graph of the streamwise velocity component
versus the wall normal coordinate, see figure 2.30a). We see that the boundary layer thickness is
much higher than the corresponding laminar flow case. This is related to higher Reynolds number
at the same streamwise positions as in the laminar case. The higher Reynolds numbers are due to
the selection of water as the fluid instead of air that has a much higher value of kinematic
viscosity than water.

********** x=0.2m
******* x=0.4m
y J S N N N N B N D x=0.6m
""""""""""""" x=0.8m
1
0
0 0.005 0.01 0.015 0.02

y(m)
Figure 2.30a) Comparison of turbulent boundary layers at Re,, = 10® — 4.04 - 10°

As an example, the turbulent boundary layer thickness from figure 2.30a) is 3.16 mm at x = 0.2 m
which can be compared with a value of 4.45 mm from equation (2.4), see table 2.2.

O (mm) O (mm) %
x (m) Simulation | Empirical | Difference | Us(m/s) | U (m/s) | v(m?/s) Re,
0.2 3.16 4.45 29 4.974 5.024 1.004E-06 | 1,000,787
0.4 6.01 8.05 25 4.992 5.043 1.004E-06 | 2,009,044
0.6 8.72 11.39 23 5.009 5.060 1.004E-06 | 3,023,958
0.8 11.31 14.57 22 5.026 5.077 1.004E-06 | 4,045,355

Table 2.2 Flow Simulation and empirical results for turbulent boundary layer thickness

Place the file “graph 2.30b)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Boundary
Layer Thickness. An Excel file will open with a graph of the boundary layer thickness versus the
Reynolds number, see figure 2.30b).
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0.1
1OOJ)OOO 16000000
F 7R A N N N I U 0 6 — Flow Simulation
- || ——— Empirical Data
0.01

Figure 2.30b) Boundary layer thickness for turbulent boundary layers at Re, = 10 — 4.04 - 10°

30. Place the file “graph 2.31” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Comparison with One-
Sixth Power Law. An Excel file will open with Figure 2.31. In figure 2.31 we compare the
results from Flow Simulation with the turbulent profile for » = 6. The power —law turbulent
profiles suggested by Prandtl are given by

U _ Yy\i/n
u (5) (2.13)
1
0.8
0.6
********** x=0.2m
u/U ******* x=0.4m
o )7 120 S N S s s N x=0.6m
""""""""""""" x=0.8m
n=6
0.2
0
0 0.2 0.4 0.6 0.8 1

y/o

Figure 2.31 Velocity profiles compared with 1/6 power law for turbulent profile
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31. Place the file “graph 2.32” on the desktop. Repeat step 24 and choose the sketch x =0 — 0.9 m,

uncheck the box for Velocity (X) and check the box for Shear Stress. Rename the xy-plot to
Local Friction Coefficient for Laminar and Turbulent Boundary Layer. An Excel file will
open with figure 2.32. Figure 2.32 is showing the Flow Simulation is able to capture the local
friction coefficient in the laminar region in the Reynolds number range 10,000 — 200,000. At Re
= 200,000 there is an abrupt increase in the friction coefficient caused by laminar to turbulent
transition. In the turbulent region the friction coefficient is decreasing again but the local friction
coefficient from Flow Simulation is significantly lower than empirical data.

0.1
1000 104)00 100000 100(I)OOO 10000000
0.01
Cf,x ********** Flow Simulation
— Theory
0.001
0.0001

Re

X

Figure 2.32 Flow Simulation (dashed line) and theoretical turbulent friction coefficients

The average friction coefficient over the whole plate Cr is a function of the surface roughness for
the turbulent boundary layer and also a function of the Reynolds number based on the length of
the plate Re;, see figure E3 in Exercise 8. This friction coefficient can be determined in Flow
Simulation by using the final value of the global goal, the X-component of the Shear Force Frand
dividing it by the dynamic pressure times the area 4 in the X-Z plane of the computational
domain related to the flat plate, see figure 2.28a) for the size of the computational domain.

_Fp 0.148166N _
Cr = ZpU2A  :998kg/m?-52m? /s2-1m-0.004m 0.002969 (2.14)
UL 5m/s-1m
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The variation and final values of the goal can be found in the solver window during or after
calculation by clicking on the associated flag, see figures 2.33 and 2.29d).

@ Solver: Flat Plate Boundary Layer Study Using Water [Default(1)] (Flat Plate Boundary Layer Study 2020.5LDPRT)

File Calculation View Insert Window Help

B> 4 |9 | BOE #e 0

i JEE | Insert Goals Table(Ctrl+T) i.:g

Figure 2.33 Current value of the global goal

For comparison with Flow Simulation results we use equation (19) with Re_,. = 200,000

0.0315 1 6
G = oo~ e (0.0315Re,,” — 1.328,/Re,; ) = 0.003378 (2.16)

This is a difference of 12%.
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M. Exercises

2.1 Change the number of cells per X and Y, (see figure 2.16b), for the laminar boundary layer
and plot graphs of the boundary layer thickness, displacement thickness, momentum
thickness and local friction coefficient versus Reynolds number for different combinations of
cells per X and Y. Compare with theoretical results.

2.2 Choose one Reynolds number and one value of number of cells per X for the laminar
boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per Y. Compare with theoretical results.

2.3 Choose one Reynolds number and one value of number of cells per Y for the laminar

boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per X. Compare with theoretical results.
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2.4 Import the file “Leading Edge of Flat Plate”. Study the air flow around the leading edge at 5
m/s free stream velocity and determine the laminar velocity boundary layer at different
locations on the upper side of the leading edge and compare with the Blasius solution. Also,
compare the local friction coefficient with figure 2.26. Use different values of the initial mesh
to see how it affects the results.

Figure E1. Leading edge of asymmetric flat plalte, see Fransson (2004)

2.5 Modify the geometry of the flow region used in this chapter by changing the slope of the
upper ideal wall so that it is not parallel with the lower flat plate. By doing this you get a
streamwise pressure gradient in the flow. Use air at 5 m/s and compare your laminar
boundary layer velocity profiles for both accelerating and decelerating free stream flow with
profiles without a streamwise pressure gradient.

Figure E2. Example of geometry for a decelerating outer free stream flow.

2.6 Determine the displacement thickness, momentum thickness and shape factor for the
turbulent boundary layers in figure 2.30a) and determine the percent differences as compared
with empirical data.

2.7 Change the distribution of cells using different values of the ratios in the X and Y directions,
see figure 2.28b), for the turbulent boundary layer and plot graphs of the boundary layer
thickness, displacement thickness, momentum thickness and local friction coefficient versus
Reynolds number for different combinations of ratios. Compare with theoretical results.
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2.8 Use different fluids, surface roughness, free stream velocities and length of the computational

domain to compare the average friction coefficient over the entire flat plate with figure E3.
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Figure E3. Average friction coefficient for flow over smooth and rough flat plates, White

(1999)
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Notes:
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